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Abstract 
 

    Adobe is a software development company established in 1982, and has developed a number of 

software applications for use in various fields.The program Animate cc (flash previously) is one of 

the most prominent products and is widely used in the design of programming and producing best 

animation websites. 

Adobe has included in Flash software releases (Adobe Flash Professional CS6, Adobe Flash 

Professional CS5.5, Adobe Flash Professional CS5 and previous releases) a text-processing 

library called Text Layout Framework (TLF). This library supports Arabic-language writing from 

right to left and supports left-to-right writing of numbers and texts written from left to right such as 

Latin numbers and letters. However, the versions of Animate cc have not include the text-

formatting library, which resulted in the inability of designers and programmers to produce 

interactive Arab applications. 

In this research, we designed a component for writing in Arabic called Arabic Text component  

that contains a wide range of fonts, text control properties and the addition of aesthetic and artistic 

effects of Arabic characters that arenotincluded in the previous versions of Flash. The ArabicText 

component is included once in the flash program components, then it is used for writing by 

inserting it into stage. 
 

Keywords: Writing Arabic text, editing Arabic text, Adobe Animate CC, Adobe Flash, Text 

Layout Framework, TLF. 

 

1. Introduction: 
Adobe is one of the leading companies in the production of multimedia design and production 

software such as Photoshop, Flash, Illustrator, InDesign, Flash Catalyst and Flash Builder 

etc.Photoshop is used to handle bitmaps, Illustrator is used to set up vector graphics, and In Design 

is a desktop publishing program used to design and publish books, magazines, publications, 

posters, and other forms of printing,Flash Catalyst is a design tool for rapidly creating expressive 

interfaces and interactive content without writing code. Flash Builder, formerly known as Flex 

Builder, is a code-centric environment geared toward developers rather than animators or 

designers to create interactive content[5]. 

Since its foundation in 1982, Adobe has released a number of Flash versions under different 

names. Flash is used to add animation and interactivity on web pages and to create content for 

Adobe, such as web applications, games, movies, and content for mobile phones and other mobile 

devices. Flash has a programming language called Action Script that is used primarily to develop 

websites and software by Adobe Flash Player. Each edition is characterized by advanced 

technologies that keep abreast of the evolution in the field of communications and information 

technology[12]. The Adobe Flash versions can be briefly reviewed inTable 1[14]. 
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Table 1: Features of Adobe Flash versions  

Versions  New features  

Adobe Flash CS3 

Professional 

Integration with Adobe Photoshop,Illustrator, improved vector 

drawing tools,ActionScript 3.0,strongly typed variables with type 

safety, runtime errors, improved events, display list instead of 

"depth" system, Socket, ByteArray, Loader, RegExp, etc.)[10][11].  

Adobe Flash CS4 

Professional 

Inverse kinematics, basic 3D object manipulation, object-based 

animation, a text engine. 

Adobe Flash Professional 

CS5 

Support for publishing iPhone applications[3], Flash-to-iPhone 

compiler, new text engine (TLF) ,and the code snippets 

panel[10]. 

Adobe Flash Professional 

CS5.5 

Content scaling and stage resizing, copy and paste layers, sharing 

symbols across FLA files, symbol rasterization, incremental 

compilation, auto-save and file recovery, and integration with CS 

Live online services[11] 

Adobe Flash Professional 

CS6 

Supports for publishing files as HTML5 and generating sprite 

sheets [9][13]. 

Adobe Flash Professional 

CC 

Changes include a native 64-bit scene rendering engine, minor 

performance improvements and bug fixes, and the removal of 

legacy features such as ActionScript 2 support. As part of the 

Creative Cloud suite, Flash CC also offers users the ability to 

synchronize settings or save files online. 

Adobe Flash Professional 

CC 2014  

Includes variable-width strokes, SVG export, and WebGL 

publishing for animations. 

Adobe Flash Professional 

CC 2014.1 

Featuring expanded WebGL publishing abilities, freedom to create 

custom brushes, and the ability to import external SWFs,software 

development kit (SDK) 

Adobe Flash Professional 

CC 2015  

Bone animation tool, H.264 videos with audio, export bitmaps, 

brush scaling with stage zoom, universal document type converter, 

improved audio workflows, improved Motion Editor, panel 

locking, faster saving of FLA files, auto-recovery optimizations, 

organize imported GIFs in library, library search by linkage name, 

invert selection, paste and overwrite frames.code snippet support 

for WebGL, improved Custom Platform Support SDK, Flash 

Player 17.0, AIR SDK (version 17.0) and CreateJS libraries. 

Adobe Animate CC 2015.1 Shifts away from the "Flash" branding signifying the ability to 

animate content and publish to video, HTML5 and Flash. It 

includes tagged color swatches, Adobe Stock and Creative 

Cloud Libraries, vector art brushes, 360° rotatable stage, resizable 

stage, export video up to 4K resolution , HTML5 ,Canvas 

improvements (TypeKit support, text as outlines, custom 

templates)[9][15]. 

Adobe Animate CC 2017 Camera support (animating the stage), creating and managing paint 

brushes, export for animated GIF, component support for HTML5 

canvas, integration of the latest Flash Player and AIR SDK and 

stage enhancements as transparent stage background 

support. Content in Animate can be created or imported it from 

other Adobe applications, Vector program, SWF files. 
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2. Flash Text Engine 
      The Adobe® Flash® Text Engine (FTE), available, starting with Flash Player 10 and Adobe® 

AIR™1.5, provides low-level support for sophisticated control of text metrics, formatting, and bi-

directional text[1][2]. It offers an improved text flow and enhanced language support. While it can 

be used to create and manage simple text elements, the FTE is primarily designed as a foundation 

for developers to create text-handling components. As such, Flash Text Engine assumes a more 

advanced level of programming expertise. The Text Layout Framework, which includes a text-

handling component based on the FTE, provides an easier way to use its advanced features. The 

Text Layout Framework is an extensible library built entirely in ActionScript 3.0[2][16].  

 

3. Text Layout Framework 

The Text Layout Framework (TLF) is an extensible ActionScript library[16]. The TLF is built on 

the text engine in Adobe® Flash® Player 10 and Adobe® AIR® 1.5. The TLF provides advanced 

typographic and text layout features for innovative typography on the web. The framework can be 

used with Adobe® Flex® or Adobe® Flash® Professional. Developers can use or extend existing 

components, or they can use the framework to create their own text components. The TLF includes 

the following capabilities[16]: 

- Bidirectional text, vertical text, and over 30 writing scripts including Arabic, Hebrew, Chinese, 

Japanese, Korean, Thai, Lao, Vietnamese, and others 

- Selection, editing, and flowing text across multiple columns and linked containers 

- Vertical text, Tate-Chu-Yoko (horizontal within vertical text) and justifier for East Asian 

typography 

- Rich typographical controls, including kerning, ligatures, typographic case, digit case, digit 

width, and discretionary hyphens 

- Cut, copy, paste, undo, and standard keyboard and mouse gestures for editing• 

- Rich developer APIs to manipulate text content, layout, and markup and create custom text 

components 

- Robust list support including custom markers and numbering formats 

- Inline images and positioning rules 

 

The TLF is an ActionScript 3.0 library which is built on the Flash Text Engine (FTE) that is  

introduced in Flash Player 10[2 ]. FTE can be accessed through the flash.text.engine package, 

which is part of the Flash Player 10 Application Programming Interface (API).The Flash Player 

API, however, provides low-level access to the text engine, which means that some tasks can 

require a relatively large amount of code. The TLF encapsulates the low-level code into simpler 

APIs. The TLF also provides a conceptual architecture that organizes the basic building blocks 

defined by FTE into a system that is easier to use. 

 

4. Complex script support Flash  
The TLF provides complex script support. Complex script support includes the ability to display 

and edit right-to-left scripts. The TLF also provides the ability to display and edit a mixture of left-

to-right and right-to-left scripts such as Arabic and Hebrew[17]. The framework not only supports 

vertical text layout for Chinese, Japanese, and Korean, but also supports tate-chu-yoko (TCY 

elements). TCY elements are blocks of horizontal text embedded into vertical runs of text.  

 

5. Using the Text Layout Framework 
The TLF is an ActionScript 3.0 library contained entirely within the textLayout.swc library. The 

TLF library contains about 100 ActionScript 3.0 classes and interfaces organized into ten 

packages. These packages are sub packages of the flashx.textLayout package. 
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5.1 Data structures and formatting classes:The main data structure of the TLF is the text flow 

hierarchy, which is defined in the elements package. The following packages contain the data 

structures and formatting classes for the TLF: 

- flashx.textLayout.elements 

- flashx.textLayout.formats 

- flashx.textLayout.conversion 

 

5.2 Rendering classes:The classes in these packages facilitate the rendering of text for display by 

Flash Player. The factory package provides a simple way to display static text. The container 

package includes classes and interfaces that define display containers for dynamic text. The 

compose package defines techniques for positioning and displaying dynamic text in 

containers.The following packages contain the rendering classes for the TLF: 

- flashx.textLayout.factory 

- flashx.textLayout.containe 

- flashx.textLayout.compose 

 

5.3 User interaction classes :The edit and operations packages define classes that you can use to 

allow editing of texts stored in the data structures. The events package contains event handling 

classes. The following packages contain the user interaction classes for the TLF: 

- flashx.textLayout.edit 

- flashx.textLayout.operations 

- flashx.textLayout.events 

 

6. Formatting text with TLF: 
The flashx.textLayout.formats package contains interfaces and classes which  assigne,formats to 

any FlowElement in the text flow hierarchy tree. There are two ways for the application of 

formatting : 

1. A specific format can be assigned  individually by you. 

2. Agroup of formats can be  simultaneously with a special formatting object. 

 

The Itext Lay out Format interface contains all of the formats that can be applied to a 

FlowElement. Some formats are applied to an entire container or paragraph of text, but do not 

logically apply to individual characters. For example, formats,such as justification and tab 

stops,are applied to the whole paragraphs, but are not applicable to individual characters. 

 

7. Problem writing in Arabic in Adobe Animate CC 
Arabic is characterized by a variety of features that are unique to all otherlanguages, including 

right-to-left writing supported by the text layout framework in Adobe Flash Professional CS5, 

Adobe Flash Professional CS5.5 and Adobe Flash Professional CS6.   In some cases, the Arabic 

text may also contain data that are  written in the opposite direction from left to right, such as 

Latin numbers and texts. In this case, the writing tool must provide the possibility of changing the 

direction of writing within the text when needed, which is called bi-directional support. 

After  developing  and restructuring  the Flash software  by Adobe company  from 32-bit to 64-bit,  

types of text in previous versions of Flash, such as static text and classic text, has been included 

except the text-format library (TLF) which hasn't been added in this  new version and which has 

reflected negatively on the Arabic text that requires conversion from  right-to-left writing 

direction, because of the style in writing Arabic texts. 
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8. Approaches used to solve the problem of writing in Arabic on Adobe Flash 

Professional CC 2014 - Adobe Animate CC 2017: 
For writing in Arabic  in Professional CC 2014 - Adobe Animate CC 2017,several ways are used  

including 
1. Using the intermediate programs that support the Arabic language: The Arabic texts are 

transferred from the application to the Adobe Animate cc in the form of a vector graphic or 

bitmap matrix file and are pasted into the target application interface, but this method has a 

number of disadvantages, such as processing (zoom, choose the appropriate font type, etc.).It 

is treated as a graphic or bitmap. There is a wide range of programs and applications that 

support writing in Arabic, including: 
- Photoshop: Using any version of  Photoshop program, where you can write in a file and save 

it in PSD and then import the file in Adobe Animate cc. 
- Illustrator: A vector-drawn program that can be written in Arabic and then copied and pasted 

into the target application interface. 

2. Using the font type _sans: The first line in the list of fonts Adobe Animate cc, which supports 

the writing in Arabic, but the most prominent disadvantages of this type of line is that the 

characters appear disjointed and reversed when writing, and supports a limited set of lines, for 

example  (اطلب العلم من المهد الى اللحد) appear in this type of line as following: 

 
9. The proposed method to solve the problem of writing in Arabic: In this research, we have 

designed ArabicTextcomponent which supports Arabic-language writing from right to left. It 

also allows the designer to change the direction of writing from left to right for left-to-right 

numbers and texts such as numbers and Latin letters. This component contains a rich set of 

properties that are used to edit and format text. The artistic and aesthetic touches of the Arabic 

script character were not previously available in Adobe Flash. 

ArabicText component features an easy-to-use user interface with a clear menu of options that the 

designer can choose from and apply to the target text to get an organized and comfortable text to 

create and design distinct Arabic applications. These tools are illustrated in Figure( 1). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Figure 1: Component parameters 
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1. Text: Typing and editing text. 

2. Underline: Underline  the text or cancel it 

3. Background: To activate the selection of colored background text or deactivate the selection of 

colored background for text 

4. Transparent Background: Specify the background transparency value 

5. Colored Background: Choose background text color 

6. Password: Convert text to password 

7. Limits: To activate the selection of transparent borders and broad borders or deactivate the 

selection of transparent borders and wide borders 

8. Transparent border: Determines the value of frame transparency 

9. Wide Boundary: Determines the value of the width of the frame 

10. Color Border: Choose color frame 

11. Font size: Character size 

12. Bold: Choose font thickness 

13. Text color: Character color 

14. Italic: To type in italics or cancel typing in italics 

15. Distance between lines: Specifies the distance between lines 

16. Space to Left: Specifies the text alignment distance of the right margin 

17. Right space: Specifies the text alignment distance for the left margin 

18. Align text: 

- Adjust: Align text from both sides 

- Centering: Centering text 

- Align Right: Align the paragraph to the right margin 

- Align Left: Aligns the paragraph to the left margin 

19. Transparent text: Refers the value of text transparency 

20. Type_ Line: Choose font type 

21. Text type:  Dynamic ( non-editable text), Insert ( editable text). 

 

10. Steps  for creating Arabic text component: 

Step 1: New Actionscript3.0 :Create a new Flash AS3 file. Save it as TextArabic.fla 

 

 Figure 2: New document 
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Step 2: Configure Flash for UIComponent :UIComponent is the base class of all Flash 

components[4]. All User Interface components which are already in Flash (like the ColorPicker, 

the Checkbox and so on) extend the UIComponent (or extend some class that extends the 

UIComponent);  

1. Go to File >ActionScript Settings… 

2. Click  "Source path", click the "+" button and add $(AppConfig)/Component 

Source/ActionScript 3.0/User Interface 

3. Click OK until you've closed  the Advanced ActionScript 3.0 Settings  windows 

 

Step 3: Create the TextArabicObject : 

1. Click Insert > New Symbol. For the name: TextArabic; type: Movie Clip; linkage: check the 

options "Export for ActionScript" and "Export in frame 1"; for the class:  TextArabic; base 

class: flash.display.MovieClip 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

2. Draw rectangle as text frame for writinginsideTextArabic. 

Create the Class, extending the UIComponent Class: 4Step  
1. right-click on the TextArabic object  

2. click "Edit class". 

3. Import the necessary classes (see appendix1). 

4. Add variables and Methods  (see appendix1). 
5. Save the class in folder where the TextArabic. 

 

Step 5:  Component Definition : 
1. open the library  

2. right-click on the TextArabic object  

3. click "Component Definition". 

 

Figure 3: Creating new symbol 

http://livedocs.adobe.com/flash/9.0/ActionScriptLangRefV3/fl/core/UIComponent.html
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Step 6 :Live Preview 

1. Right-click over the TextArabic component 

2. Click "Export SWF" and export in the same folder of the TextArabic.fla file.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 4: Component class definition 

Figure 5: Component parameters definition 
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Step 7 :Implementing the Live Preview: 

1. Right-click on the TextArabic component  

2. Click the option "Component Definition" 

3. Click the button "Set..." in the Live Preview section. 

4. Select the option "Live preview with .swf embedded in .fla file 

5. Click Browse  

6. Select  TextArabic .swf file. 

 

Step 8: Exporting   SWC file : 

1. Right-click over the TextArabic component 

2. Click "Export  SWC  file   

3. Save it as TextArabic.swc   in the  any  folder. 

 

11.  Steps using Arabic text component: 

1. CopyTextArabic.swcfiletoC:\Program Files\Adobe\Adobe Animate CC 

2017\Common\Configuration\Components. 

2. Close Adobe Animate cc. 

3. Again reopen AdobeAnimate cc to updating list components. 

4. Create a new Actionscript 3.0 file and save it anywhere. 

5. Go to Window > Components. 

6. Drag the TextArabic component on to the stage. 

7. Click  "properties window".There, you can see the parameters of TextArabic component, so 

Type  arabic text and change the parameters  of the component and you will see the live 

preview update. 

 
12. Results:In order to design unique Arabic applications using Adobe Animate cc, we designed 

ArabicText component that supports Arabic writing from right to left. It also allows the 

designer to change the direction of writing from left to right for numbers and texts written 

from left to right such as numbers and Latin characters. This component contains a set of 

properties that are used to edit and format text and to provide artistic and aesthetic touches to 

the character of which the Arabic text is composed of. These features were not previously 

found in any of the Adobe Flash versions. 

 

13. Conclusion: The design and creation of the TextArabic component is a great addition to the 

Adobe Flash versions. The designer and programmer enriches the use of middleware for 

writing in Arabic because the texts written by intermediate programs are not capable of 

processing (zoom, select the appropriate font type, etc.) in the form of a graphic or a bitmap. 

The TextArabic component allows editing, formatting and controlling of text, and adding 

artistic and aesthetic touches through a set of properties. 
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 الملخص
 

Adobe     وقد طورت عددا من التطبيقات  م1982وير البرمجيات  انشئت عام هي  شركة متخصصة في تط ,

)الفلاش سابقا( من ابرز منتجاتها  Animate ccالبرمجية لاستخدامها في  مجالات مختلفة, ويعد برنامج 

ويحظى باستخدام واسع في مجال التصميم والبرمجة  و انتاج المواقع الالكترونية المليئة بالحركة. ويتميز 

لمميزات التي جعلته من اكثر البرامج استخداما في تصميم صفحات الانترنت بالعديد من اAnimate ccبرنامج 

 المتحركة والتفاعلية.

الاصدارات السابقة مكتبة و  CS5 وCS5.5و  CS6في اصدارات برامج  فلاش Adobeلقد ضمنت شركة 

, وهذه المكتبة تدعم الكتابة باللغة العربية من اليمين  Text Layout Framework (TLF)لتنسق النصوص تسمى

الى اليسار كما انها تدعم الكتابة من  اليسار الى اليمين للأعداد والنصوص التي تكتب من اليسار الى اليمين 

لم  تتضمن هذه المكتبة, مما نتج عن ذلك عدم  Animate ccكالأرقام والحروف اللاتينية, الا ان اصدارات  

 المصممين والمبرمجين على انتاج تطبيقات عربية تفاعلية متميزة. ةقدر

خصائص يحوي مجموعة كبيرة من الخطوط و لقد قمنا في  هذا البحث  بتصميم مكون للكتابة باللغة العربية

يتم اصدارات فلاش السابقة.  التحكم بالنص واضافة المؤثرات الجمالية والفنية للحرف العربي لم تتضمنها

مكون الكتابة باللغة العربية مرة واحدة ضمن مكونات برنامج الفلاش, ومن ثم يستخدم  للكتابة من خلال  ادراج

 ادراجه الى مسرح العرض. 
 

كتابة النص العربي, تحرير النص العربي, أدوبي فلاش, أدوبي انيميت سي سي, مكتبة مفتاحية: الكلمات ال

 تنسيق النصوص.  
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